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Preface

The preface is an informal statement from the author(s) to the reader about the research project and the report.  Usually the preface describes the general issue addressed in the report and the reasons for choosing to research the topic.  You may also include a general statement about the value of the research or the special applications to which it pertains.  The preface, however, is not an abstract of the report.

The preface is the place to acknowledge the assistance you received.  Guidance and assistance from your research advisor and other faculty are usually acknowledged.  Substantial help from librarians, sponsoring organizations, or members of outside organizations may also be acknowledged.  If acknowledgments are the only material provided in the preface, this section can be labeled “Acknowledgments” rather than “Preface.”  Because the preface is an informal statement from the author(s) to the reader, it is usually written in the first person, and the reader may be addressed in the second person.  Elsewhere in the report, third-person form should be used.

au/school/NNN/2004-04

Abstract

All Air University research papers must contain an abstract.  The length of the abstract should not exceed two pages.   It should be roughly 200 words.  The abstract is the last item included in the prefatory material.  It summarizes the information contained in the report.  The main items described in the abstract include the problem statement, the methodology followed in conducting the research, the findings, and the conclusions.  Obviously, it is impossible to say very much about all of the aspects of the paper in 200 words.  But the reader should at least discover the content and the methods used in the thesis by reading the abstract.  The abstract is not a preface; it is a succinct statement of the important aspects of the research.  Students should be aware that abstracts are usually republished in other reference volumes or electronic databases (including the Air University Research database).  Republishing helps other researchers keep informed about developments in the field or provides a means of identifying reports that they may want to obtain and read.

Chapter 1

Using This Template

To me style is just the outside of content, and content the inside of style, like the outside and the inside of the human body—both go together, they can’t be separated.

—Jean-Luc Godard

This template is designed to facilitate the development of a professional-quality research product and allow the researcher to focus on matters of substance rather than format.  Hopefully, it will allow the writer to develop a product that meets Air University standards without having to become an expert in Microsoft Word.

Creating the Research Document

First the template itself must be placed in the same directory as other Word templates (normally, C:\WINDOWS\APPLICATION DATA\MICROSOFT\TEMPLATES).

To create a new document, open Microsoft Word and select New from the File menu.  Choose research.dot as the template and click OK.  Once the initial document is created, it can be modified as needed to build the research paper.  Typing over existing text:  (1) On the Tools menu, click Options, and then click the Edit tab.  (2) To replace existing text as you type, select the Overtype mode check box. 

Several ways normally used to create a new document will not work, however.  For example, clicking on the new document button on the toolbar will not work, since it does not provide any options for selecting the research template (it will use the Normal template, instead).  Double clicking on the research template will open up the template for editing and will not permit any changes to be saved to a .doc file.

The template itself serves two purposes: (1) to provide the format needed to produce the research product and (2) to serve as an example of the layout and format of such a document.  The remainder of this document will describe each element of the research paper and will explain how they are to be applied using Microsoft Word.
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Figure 1  Microsoft Word Template

**NOTE:  The Template itself must be placed in the same directory as the other Microsoft Word templates (e.g. C:\WINDOWS\APPLICATION DATA\MICROSOFT\TEMPLATES).  Once the document is created, it can be modified as needed to build the research paper.

Glitches


Several ways normally used to create a new document will not work:

1. Double–clicking on the template file will open up the template for editing and will not permit any changes to be saved to a .DOC file.

2. Clicking on the new document button on the toolbar will not work either since it doesn’t provide options for selecting the research template.

Front Matter

The front matter for the research paper should include (in the following order) the title page, disclaimer, table of contents, list of illustrations (if the paper includes figures), list of tables (if the paper includes tables), preface (and/or acknowledgments), and abstract.  The preface and abstract in this sample document contain additional information about what should be contained in those sections.  The remaining sections of the front matter are explained below.

Title Page

The title page contains basic information about the research paper: the research project designator; title of the research paper; an indication for whom the research product was prepared and for what purpose; the rank and full names of the author(s) (first name, middle initial(s), and last name) and advisor; and the date the project was completed (month and year).

Style Elements.  Each element of the title page uses its own style—a predefined description in Microsoft Word which defines how that element will look.  The style describes formatting characteristics of an element, such as font size, line spacing, text position, and tab settings.  Chapter 2 discusses more details of how to apply style elements  and appendix B contains a complete description of each style element.  The easiest way to create the title page is to simply modify the example contained in this template.

Project Designator.  The project designator is a unique identifier for each project used by the Defense Technical Information Center (DTIC) to provide information on the agency, department, project number, and date of completion for each report in their database.  For Air University research, the project designator should be:

AU/SCHOOL/NNN/2004-04

SCHOOL is the school which prepared the report (e.g., AWC, ACSC, or SAASS), NNN is the assigned project number (e.g., 123 for Project 123), and 2004-04 is the year and month the project is due (April 2004).  The project designator uses the Title Page Designator style on the title page and the Abstract Page Designator style on the abstract page.

Author(s).  The list of authors is handled differently depending upon the number of authors.  For one to four authors, a single-column format is applied using the Authors 1 Column style.  For five to eight authors, a double-column format is applied using the Authors 2 Column style, with the last author’s name formatted as Authors 1 Column style in the case of five or seven authors; tab characters are used before each author’s name.

Disclaimer

The disclaimer should be included exactly as it is in this template.  No modifications will be made.

Table of Contents

The table of contents (and lists of illustrations and tables) is already pre-formatted to meet all Air University formatting requirements.  The title “Contents” is set using the Table of Contents style and the “Page” heading is set with the Page Header style.  To update the table of contents, click on it once with the left mouse button (the entire piece will highlight) and then click on it with the right mouse button.  On the pop-up menu, select Update Field, then choose either Update Page Numbers Only (if no entries have been added, deleted, or changed) or Update Entire Table (if any changes to the entries are needed).  This style will automatically update the disclaimer, list of illustrations, list of tables, preface (acknowledgments), and abstract.  It will also update all chapter/appendix titles and level-one and level-two subheadings—as long as they are marked throughout the text with the appropriate style.  The next chapter discusses how to mark heading styles.

The user-defined table of contents and lists of illustrations and tables should never be manipulated using Insert|Index and Tables… on the pull-down menu.  Doing so can result in a complete loss of the predefined styles for these items.
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Figure 2  Example Update Table of Contents

Modifications to Table of Contents.  Due to limitations in Microsoft Word, three modifications should be made to the final table of contents.  The first modification is that while the list of illustrations and list of tables are titled “Illustrations” and “Tables,” respectively, they should be listed in the table of contents as “LIST OF ILLUSTRATIONS” and “LIST OF TABLES.” These modifications is made by simply typing “LIST OF” manually on each line after generating the final table of contents.  The second modification is to type the appendix number (e.g., “APPENDIX A:”) to each appendix title; this modification can be made the same way.  Finally, the roman numerals for page numbers in the front matter will need to be changed from uppercase to lowercase.  This modification is made by selecting each number, then right clicking, and deselecting All Caps from the Font… dialog box.
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Figure 3  Example Font Dialog Box

List of Illustrations and Tables

The list of illustrations and list of tables is preformatted to work the same as the table of contents.  Each list is updated using the same steps taken as with the table of contents.  Figures and tables are automatically included in these lists as long as a caption is created by selecting Caption from the Insert menu when creating the figure or table.  Inserting figures and tables are discussed later in this document in chapter 4.

Preface (Acknowledgments) and Abstract

Information on what type of information should be included in the preface (acknowledgments) and abstract are included in the corresponding sections of this document.

Chapter 2

Selecting Styles

Style is the dress of thoughts; and let them be ever so just, if your style is homely, coarse, and vulgar, they will appear to as much disadvantage, and be as ill received, as your person, though ever so well-proportioned, would if dressed in rags, dirt, and tatters.

—Lord Chesterfield

Each part of the research paper document has a style element.  These style elements combine to describe the overall format of the research paper.  Style elements are used to determine the font, font size, vertical and horizontal positioning, and other characteristics of this document.  To see which style element is in use for a particular part of the document, click on that item in the document and look in the Style box on the Formatting toolbar.
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Figure 4  Microsoft Word Toolbar

In figure 4, the Style Box shows the Normal style selected.

Default Styles

Depending upon which part of the document is selected, various styles control the assorted elements of a section.  For example, the designator on the abstract page is formatted using the Abstract Page Designator style.  The beginning of each section in the front matter has a style for the title (Disclaimer, Table of Contents, List of Illustrations, List of Tables, Preface, or Abstract) that not only defines how the title should look, but how it should be included in the table of contents—these should not be modified.

Breaks Between Sections

The breaks between sections should all be section breaks and not page breaks.  To start a new chapter or appendix, mark the chapter number (e.g., “Chapter 1”) with the Chapter Number style and then insert a section break in front of it by selecting Insert|Break|Section Breaks|Next Page from the pull-down menu.  Note that using section breaks will not only add page breaks before chapters, appendices, or other sections, but it will also force the proper placement and formatting of the endnotes.
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Figure 5  Example Section Break

Page Numbering.  Although the page-numbering scheme is already set for this document, it is possible for problems to arise when inserting and deleting section breaks.  The front matter is counted consecutively, using lowercase roman numerals, starting with title page as page i through the abstract—the title page itself, however, is not numbered.  The main body of the document begins with the first page of chapter 1 and is counted consecutively from page 1 through the end of the document (the bibliography).

Default Chapter Styles

Each chapter begins with the Chapter Number style.  Immediately following that element is the Chapter Title style which formats the chapter title and sets an entry for table of contents.  The first two levels of subheadings, Subheading 1 and Subheading 2 are also predefined—once the subheading is typed and the style selected, these elements are formatted and entries are generated for the table of contents.  The next level of subheading simply uses the default style for the paragraph (naturally enough, the Paragraph style)—the subheading itself is in title case and boldface and ended with a period (this level of subheading is not included in the table of contents).

Paragraph Styles.  The Paragraph style is the default style for text within the body of the research paper.  This style automatically sets double-spacing, margins, and indentation for the paragraph—there is no need to use tabs at the beginning of the paragraph or extra linefeeds to space between paragraphs.  In instances where a figure or table is inserted in the middle of a paragraph, the Unindented Paragraph style is used to continue the paragraph.

Block Quotations.  Block quotations are marked using the Block Quotation style.  To demonstrate an example of the Block Quotation style, this section on block quotations is quoted from the Air University Style Guide for Writers and Editors:

Use block quotations for passages that are easily set apart from the text, that are 10 or more typed lines, or that involve more than one paragraph.  Indent from both sides and single-space the quoted material.  Do not use quotation marks to enclose the quotation, and do not indent for paragraphing.  Indicate a new paragraph in a block quotation by skipping a line.  The block quotation should reflect the paragraphing of the original.

Epigraphs.  An epigraph is a pertinent quotation which is used to start off a chapter.  Examples of epigraphs can be seen at the beginning of each chapter in this document.  The body of the epigraph is marked as a block quotation in an italic font using the Epigraph Text style.  The source of the quotation follows below the text and is set flush right using the Epigraph Source style.  For more information on epigraphs, see the Air University Style Guide for Writers and Editors.

Lists.  Another relevant style within the chapter is the style for enumerated lists.  An example is provided below.

There are four parts of the research paper that are single-spaced rather than double-spaced.  These are:

1. Lists (such as this one)

2. Endnotes

3. Captions

4. Bibliography

To create a numbered list, simply select the Lists style at the beginning of a blank line and then type the list items.  Each subsequent carriage return will automatically number the next item in the list.  A bulleted list may be created using the Bulleted Lists style.

Appendices, Glossary, and Bibliography

Creating a new appendix is done the same way as creating a new chapter except that appendices are “numbered” using capital letters.  Begin by typing the appendix number (e.g., “Appendix A”) on a line and then selecting the Chapter Number style.  A carriage return will select the Chapter Title style for the following line and the title of the appendix can be entered.  Note that as with chapters, a section break should replace the normal page break at the top of the page.  All other style elements are the same.

A glossary of technical terms or abbreviations may be included after the appendices as an aid to the reader.  Details on the style of the glossary can be found in the example included toward the end of this document.

The final section, the bibliography, uses the Bibliography style for the title and the Bib Entry style for each of the entries.  The format for bibliographic entries can be found in the Air University Style Guide for Writers and Editors.

Summary and Cautions

All the styles needed for the research paper are already defined.  In any instance where it is believed a new style is needed, the writer should contact the OPR for this document (CADRE, Airpower Research Institute, Research Support Division) directly for further guidance.  Under no circumstances should the user modify any style elements provided herein.

Chapter 3

Citations and Endnotes

Next to the originator of a good sentence is the first quoter of it.  Many will read the book before one thinks of quoting a passage.  As soon as he has done this, that line will be quoted east and west.

—Ralph Waldo Emerson

Whenever a citation is needed in the text of the document, select Insert|Footnote from the menu and click on Endnote and AutoNumber for the options.  This action will result in an endnote number being placed at the point of insertion and allow the text of the endnote to be typed on the endnote page (in Page Layout view; in a separate window in Normal view).  The user can move back and forth between these two locations by double clicking on the endnote number.  Examples of proper formats for endnotes can be found in Air University Style Guide for Writers and Editors.
 Note that endnotes are placed at the end of each chapter or appendix and numbered separately for each section.
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Figure 6  Example Footnotes and Endnotes

Endnote numbers are put at the end of a sentence, or at least at the end of a clause.
 “Use of more than one note reference at a single text location (such as 5,6) should be rigorously avoided.  Instead, the notes referred to should be combined into a single note.”

Placement of the endnotes at the end of the chapter, the header style, and format of endnotes should not be modified by the user.

Chapter 4

Working With Figures and Tables

Data is what distinguishes the dilettante from the artist.

—George V.  Higgins

Perhaps one of the least straightforward aspects to creating research documents using Microsoft Word involves determining how to insert figures or tables.  This chapter presents the basics necessary to make this process much simpler.

Inserting Figures

The basic process for inserting figures is reasonably straightforward.  First, the figure must exist in a format which Microsoft Word can recognize—typically a Microsoft Windows bitmap (.bmp file) or a Microsoft Windows metafile (.wmf file).  Position the cursor on a blank line formatted with the Picture style and select Insert|Picture from the pull-down menu.  Once the file is selected, it is placed on the page at the point of insertion.

Now, click to select the picture and select Insert|Caption to add a caption below the figure.  The text of the caption must be added following the label, using title case.  The caption will be numbered automatically and formatted using the Caption style.  And, of course, the caption will automatically generate an entry for inclusion in the list of illustrations.

[image: image10.png]rosoft Word - Document2

Insert Format Tools Table

Break.
Page Numbers.
Date nd T,

(o] autoText »
e

Symbl.
13 Comment

Footaote.
Coption
Cross teference,
i Index and Tables.

TextBox =]

Fie. e
- @ autoshapes

?’Zﬂd k Al wordar
o & From Scanner
- ¥ Hyperink... Ctrl+k Wl oot

m il




[image: image11.png][ Microsoft Clip Gallery 3.0

(3] Clip Art Pictures \ s Sounds "E}l Videos \

=l Insert

Peane |

People at Wark
Pleris Close.
Science & Teshn =

Screen Beans

Seasons Eind
Shapes

Signs Help

Special Docasion
Sports & Leisue

5ymbols
Transpotation

Trovel ™ Magniy

[Web Backgounc

[Web Barners _ Cipatinttis
[Web Buitons categoy: 657
[Web Dividers

Lweb Navigalors Scrol down o view

=] morecipat

£ Cos. | _CioPrpetes. | gt .|
T e Sy





Figure 7  Example Inserting Clip Art


[image: image12.png]insere. Famar 1o Tabe

[ozalal s

wormal e PageNumbers,
e nd e
ot .
el I
Symbol.

2 Compent

e .
Testoox

e

Object.

Bookmark.

: & roperir.,_cuiek






[image: image13.png]Caption:
T
Label [Fawe =] | tewtabel
.

atocapon._| o | ol |





Figure 8  Example Figure Caption

Inserting Tables

Working with tables, unfortunately, can be fairly complicated.  To insert a table in the document, start on a blank line formatted using the Normal style, then select Table|Insert Table… from the pull-down menu.  Choose an appropriate number of rows click OK.  The top portion of table 12 from the AU Style Guide for Writers & Editors is used below as an example.
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Figure 9  Example Inserting Tables

Table 1.  Sample Table

	
	1900
	1906
	1910

	Party
	% of
	Seats
	% of
	Seats
	% of
	Seats

	
	Vote
	Won
	Vote
	Won
	Vote
	Won

	
	Provincial Assembly

	Conservative
	35.6
	47
	26.0
	37
	30.9
	52

	Socialist
	12.4
	18
	27.1
	44
	24.8
	39

	Christian Democrat
	49.2
	85
	41.2
	68
	39.2
	59

	Other
	2.8
	0
	5.7
	1
	5.1
	0

	Total
	100.0
	150
	100.0
	150
	100.0
	150


Source: College of Aerospace Doctrine, Research and Education, AU Press Style Guide for Writers & Editors (Maxwell AFB, Ala.: Air University Press, December 1994), 85.

This table was created using seven columns and nine rows.  Columns were merged for the years labels (i.e., 1900, 1906, 1910) by selecting the cells to merge and selecting Table|Merge Cells.  Alignment within the table is accomplished by selecting the desired cells and clicking the Align Left, Center, Align Right, or Justify buttons on the Formatting toolbar.  A caption is added above the table by selecting Insert|Caption|Table then simply type the caption following the label, using title case.  If citing data from another source, be sure to indicate so using a “Source” statement below the table (as shown above) rather than footnoting the caption.
 Use the Normal style for this item.

Selecting Borders and Shading… from the Format menu controls placement of lines within the table.  This menu allows the user to control the placement, thickness, and color of the grid lines within the table.  Unfortunately, the scope of this document does not permit further detail into the intricacies of table formatting.  For further information on working with tables, consult your local Word expert.

Chapter 5

Conclusions

Life is the art of drawing sufficient conclusions from insufficient premises.

—Samuel Butler

Notebooks
This document, and its associated Microsoft Word template, is designed to take most of the effort out of the process of formatting a research paper, with the goal of producing a uniform professional standard for Air University papers.  While it covers the majority of formatting issues which might arise, it is not all inclusive.  It relies heavily on the Air University Style Guide for Writers and Editors and The Chicago Manual of Style to define stylistic issues—it is up to the user to be familiar with these sources.

Obviously, not all formatting issues will be resolved with this document.  It is hoped, however, that this version will provide a good starting point.  As comments and suggestions for improvement are received, they will be incorporated, with the goal of making the writing process even easier.  Ideas on how to improve this document should be sent to CADRE, Airpower Research Institute, Research Support Division, Maxwell AFB Montgomery, Al 36112-6428.

Appendix A

Sample Appendix

This section is provided to illustrate how to include an appendix in the document and show how the title is included in the table of contents.  As noted in The Chicago Manual of Style,

Some kinds of material properly relegated to an appendix are explanations and elaborations that are not essential parts of the text but are helpful to a reader seeking further clarification; texts of documents, laws, and so forth, illustrating the text; and long lists, survey questionnaires, or sometimes even charts or tables.  The appendix should not be a repository for raw data that the author was unable to work into the text.  (Emphasis added)

As noted by the preceding reference, endnotes for an appendix go at the end of that appendix.

Appendix B

Research Template Style Descriptions

To aid in the use of the style elements contained in this document, the following descriptions are provided as a reference:

Abstract
Format for the header on the abstract page.  This style will auto​matically add an entry to the table of contents.

Abstract Page Designator
Format for the project designator (used by DTIC) on the abstract page.  Note that there is a different format for the designator used on the title page (see Title Page Designator).

Acknowledgments
Format for the header on the acknowledgments page.  This style will auto​matically add an entry to the table of contents.

Authors 1 Column
Format on the title page for a single column of authors (up to four).  This format automatically centers each author’s name on the page.  Blank lines (using this style) are used to maintain the position of the date on the last line of the title page.  

Authors 2 Column
Format on the title page for two columns of authors (five to eight).  This format requires the user to tab to a position in one or the other column for proper placement; names are centered in each column.  The Authors 1 Column style may be used for the last author in the case of an odd number of authors.  Blank lines (using this style) are used to maintain the position of the date on the last line of the title page.

Bib Entry
Format for each entry in the bibliography.  This style defines the hanging indent used for bibliography entries.

Bibliography
Format for the header on the bibliography page.  This style will auto​matically add an entry to the table of contents.

Block Quotation
Format for a block quotation.  This style indents the quotation from both margins and switches to single-spaced text.

Bulleted Lists
Format for non-enumerated lists.  This style applies the proper margins and switches to single-spaced text.  Use Lists for enumerated lists.

Caption
Format for captions (legends) for figures and tables.  This style is used when selecting Insert|Caption… from the pull-down menu.  This style will auto​matically add an entry to the list of illustrations or list of tables, as appropriate.

Chapter Number
Format for the chapter (e.g., Chapter 1) or appendix (e.g., Appendix A) number for each section.  Applying this style to any text will automatically produce a page break, however, the page break must be replaced with a section break (use Insert|Break… on the pull-down menu) to ensure proper placement of endnotes at the end of each chapter or appendix.

Chapter Title
Format for the chapter or appendix title.  This style will auto​matically add an entry to the table of contents.  The chapter title should be in title case in the main body—it will be automatically converted to uppercase in the table of contents.

Definition
Format for a definition entry in the glossary.

Disclaimer
Format for the header on the disclaimer page.  This page should not be modified in any way.

Endnote Reference
Format for the endnote mark (a superscripted number), both in the body and the endnotes.  Because the marks in each portion of the document must be the same, it is not possible (using Microsoft Word) to conform to the requirements specified in the Air University Style Guide.
Endnote Text
Format of the endnote text.  This style is automatically selected when using Insert|Footnote… from the pull-down menu.

Epigraph Source
Format for the source (individual and written reference) of an epigraph.  This style positions the source flush right (aligned with the right side of the epigraph text) but italics will need to be added separately for a text reference.  A blank line (using this style) is needed to separate the epigraph source from the following paragraph.  For examples of epigraphs, see the begin​ning of chapters 1 through 5.

Epigraph Text
Format for the text of an epigraph.  This style puts the quotation in italics in the Block Quotation style.  For examples of epigraphs, see the beginning of chapters 1 through 5.

Equation
Format for an equation.  Adding a tab before the equation centers the equation and the equation number is placed flush right by adding a tab after the equation.

Glossary
Format for the header on the glossary page.  This style will automatically add an entry to the table of contents.

Glossary Text
Format for text (typical list of abbreviations) in the glossary.

List of Illustrations
Format for the header on the list of illustrations page.  This style will auto​matically add an entry to the table of contents.

List of Tables
Format for the header on the list of tables page.  This style will automatically add an entry to the table of contents.

Lists
Format for enumerated lists.  This style applies the proper margins and switches to single-spaced text.  Use Bulleted Lists for non-enumerated lists.

Normal
This style defines the basic font (Times New Roman) and font size (12 pt) for this template.  It should be used for text in tables and the source statement following a picture or table.

Notes
Format for the endnotes separator and endnotes continua​tion headers.

Page Header
Format for the header on the table of contents, list of illustrations, and list of tables to place the word “Page” at the top of the column of page numbers.

Page Number
Format for the page number at the bottom of each page.  This style is automatically generated for each page.  Control of numbering within the document is done using the Insert|Page Numbers… option on the pull-down menu.

Paragraph
Format of all paragraphs in the document.  This style indents the first line (no tab is necessary) and double-spaces the text.  For instances requiring unindented text, see the Unindented Paragraph style.

Picture
Format for pictures.  This style will automatically center the picture and keep it with the accompanying caption.

Preface
Format for the header on the preface page.  This style will auto​matically add an entry to the table of contents.

Subheading 1
Format for the first-level subheading.  This style will auto​matically add an entry to the table of contents.  The subheading should be entered using title case.

Subheading 2
Format for the second-level subheading.  This style will auto​matically add an entry to the table of contents.  The subheading should be entered using title case.  Note that there is no style for third-level subheadings and these headings do not appear in the table of contents.  See chapter 2 for details on the format of subheadings.

Table of Contents
Format for the header on the table of contents page.

Title Line 1
Format for the first line of the project title.  If the title is too long to fit on a single line, use the Title Line 2 style for the second line.  The title should be no more than three lines long.  The project title is automatically converted to upper​case.

Title Line 2
Format for the second line of a title.  The project title is automatically converted to uppercase.  If there is no second line, a blank line with this format should be retained.

Title Line 3
Format for the third line of a title.  The title should be no more than three lines long.  The project title is automatically converted to uppercase.  If there is no third line, a blank line with this format should be retained.

Title Page Advisor
Format for the advisor(s) of the project.

Title Page Base
Format for the location of the base where the school is located (e.g., “Maxwell Air Force Base, Alabama”).

Title Page By
Format for the portion of the title page which reads “by.” This item is not normally modified by the writer.

Title Page Center 1
Format for part of the central text of the title page (“A Research Report Submitted to the Faculty”).  This item is not normally modified by the writer.

Title Page Center 2
Format for part of the central text of the title page (“In Partial Fulfillment of the Graduation Requirements”).  This item is not normally modified by the writer.

Title Page Date
Format of the date at the bottom of the title page.  This style centers the date on the page.

Title Page Designator
Format of the designator on the title page.  This style ensures that the designator is in all caps and provides the proper spacing before the beginning of the project title.

Title Page School
Format for the school name on the title page.

Title Page University
Format for the university name on the title page.

TOC1
Format for level-one headings in the table of contents.  This style is automatically set in the definition of the style for the table of contents and is not used by the writer.

TOC2
Format for level-two headings in the table of contents.  This style is automatically set in the definition of the style for the table of contents and is not used by the writer.

TOC3
Format for level-three headings in the table of contents.  This style is automatically set in the definition of the style for the table of contents and is not used by the writer.

TOC4
Format for level-four headings in the table of contents.  This style is automatically set in the definition of the style for the table of contents and is not used by the writer.

Unindented Paragraph
Format for unindented paragraphs.  This style is identical to the Paragraph style except it does not indent the first line.  This style is used after an item (such as a list or an equation) is inserted in the middle of a paragraph to format the subsequent text.

Glossary

Include a glossary if you use a number of unfamiliar or technical terms in your text.  Arrange the words, abbreviations, or acronyms and their definitions in alphabetical order, and place the glossary before the bibliography.  For a list of abbreviations, use the following format (the Glossary Text style) with single-spaced entries and a blank line to separate letters:

ACSC
Air Command and Staff College

AFFP
Air Force Fellows Program

AFIT
Air Force Institute of Technology

AU
Air University

AWC
Air War College

CADRE
College of Aerospace Doctrine, Research and Education

CCAF
Community College of the Air Force

DOD
Department of Defense

SAASS
School of Advanced Air and Space Studies

USAF
United States Air Force

For definitions, use the Definition style, as shown below:

computer.  An electronic machine that performs high-speed mathematical or logical calculations or that assembles, stores, correlates, or otherwise processes and prints information derived from coded data in accordance with a predetermined program.

laser.  Any of several devices that convert incident electromagnetic radiation of mixed frequencies to one or more discrete frequencies of highly amplified and coherent visible radiation.

microwave.  Any electromagnetic radiation having a wavelength in the approximate range from one millimeter to one meter, the region between infrared and shortwave radio wavelengths.
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